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Add Customer Field Descriptions
Add Customer Field Descriptions

DescriptionField

Enter the name of the customer. You can enter a maximum of 15 characters.

One customer can have multiple sites. Each site needs one BE4000
appliance. Each site is configured separately.

Note

Customer Name

Enter the location of the customer. You can enter a maximum of 15 characters.Location

Enter the email address of the customer administrator.Customer Admin Email

Enter the name of the customer administrator.Contact Name

Enter the phone number of the customer administrator.Phone Number

Select an existing customer site template. Template saves the site configurations
(connectivity details, dial plans, stations, call routing and feature details). Using
template, you can avoid rekeying the configuration details while creating a new
site similar to an existing site configuration.

If you are creating a site for the first time, you may not find any
existing templates listed in the drop-down.

Note

Template Name
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Connectivity Field Descriptions

The following IP Networks are not supported:

• 10.0.1.x/24

• 10.0.2.x/24

• 10.0.3.x/24

• 10.1.1.x/24

• 10.1.2.x/24

• 10.1.3.x/24

• 10.2.x.x/16

• 10.3.x.x/16

Note

LAN Connection Field Descriptions

DescriptionField

Network Details

Enter IP address of the BE4000 appliance. Ensure that the IP address matches
with that of the customer subnet address and ports (UDP 500, UDP 4500, and
ESP 50) are connected, active, and reachable to the internet. Check the status of
the ports using Cisco Business Edition 4000 Port Check Tool.

BE4000 IP Address

Enter the IP address of the voicemail server. Voicemail IP address cannot be the
same as BE4000 IP address.

Voicemail IP Address

Enter the IP subnet mask. For example, 255.255.255.0 is an IP subnet mask.Subnet Mask

Enter the default gateway address.Gateway Address

Enter the ISP label. In case, there are issues in deploying the BE4000, the ISP
label helps technicians to check if the fault is with the service provider. ISP label
is an arbitrary identifier.

Internet Service Provider
(ISP)

SMTP Server - Enables Voicemail to Email Functionality

The SMTP Server configuration is required for voicemail to Email functionality, wherein voicemail received
by an extension is sent as an email attachment to the registered email address.

• If the customer has Office 365, Configure Office 365 first.

• If the customer has their own SMTP relay (other than Office 365), ensure that the proprietary certificates
of the SMTP relay are trusted by BE4000.
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DescriptionField

Enter the IP Address or Domain Name of the SMTP server. You can enter a
maximum of 100 characters for the domain name.

You can configure Fully Qualified Domain Name (FQDN) of public
SMTP servers only. BE4000 handles all Domain Name System (DNS)
resolutions through the internet and thus only public FQDNs are
accepted. For example, smtp.office365.com, smtp.gmail.com.

Note

IP Address or Domain
Name

Enter the port number. Default value is 25.Port

Choose one of the secure modes:

• None

• SSL—Provide ways to encrypt a communication channel between two
computers.

• STARTTLS—An extension to the Simple Mail Transfer Protocol (SMTP)
service that allows an SMTP server and client to use Transport Layer Security
(TLS) to provide private, authenticated communication over the internet.

Security Mode

Enter an email address that is used as “From” address to send emails containing
voicemail as an attachment. Ensure that the SMTP server allows receiving emails
from the entered email address.

Sender's Email Address

Check the "Authenticate" check box to ensure that the voicemail to email
functionality is secure. Enter a username and password that needs to be filled by
the users while accessing the voicemail from email.

Authenticate

System Settings Field Descriptions

Choose unique digits for dialing an outside line, sending a call to voicemail automatically, and dialing an
intercom extension.

Note

DescriptionField

Choose a digit to make a call to an outside phone number. You can set any digit
between 0 to 6, 8, and 9. You cannot set * and 7. Default is 9. Users should dial
this digit before dialing an external phone number.

Dial an Outside Line

Choose the total number of digits in an extension. You can set your extension
to contain 3, 4, or 5 digits. Default is 4.

Extension length

Choose the number of seconds to wait after each digit is entered, before assuming
the caller has finished entering digits. Range is from 0 to 9. Default is 5.

Interdigit Timeout

Choose a digit to dial for sending a call to voicemail automatically. Range is
from 1 to 6. Default is 2.

Send to Voicemail
Automatically
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DescriptionField

Choose a digit to dial for making an intercom call. Range is from 1 to 6. Default
is 4.

Intercom

Advanced Options

Choose to enable or disable forwarding local. This decides if internal (local)
calls can be forwarded.

Forwarding Local

Set the phone redirect limit. Limits the maximum number of 3XX responses
that can be accepted for a single call. Range is from 5 to 20. By default, 5 is
entered.

Phone Redirect Limit

Direct Inward Dial (DID)

Direct Inward Dial (DID) numbers are the registered numbers received from your service provider. Add the
DID numbers for the SIP and ISDN (PRI and BRI) connections. Do not add FXO line numbers here. The
FXO line numbers can be added while adding Line Cards (NIM) details.

DID numbers can be added in two ways:

• Click "Add Row" and add the DID numbers and service name one by one.

• Download the template provided on the screen. Fill in the details and upload all the DIDs in one go.

• DID numbers must be entered in E.164 format. A minimum of 10 digits is required for the DID number.
For example: +14155552671

• Only up to 98 DID numbers are supported for SIP trunks and 98 DID numbers for ISDN trunks (PRI
and BRI).

Note

Direct Dial Numbers Field Descriptions

DescriptionField

Click to add DID numbers manually.Add Row

Click to download the template provided on the screen.Download Template

Click to browse and upload the file containing DID numbers.Choose file

Enter a service name for each DID. Provide any name that is easy to identify the
service to which each DID number belongs to.

Service Name

Add the DID numbers received from your service provider for each row.Registered Numbers

You can delete the individual rows of DID numbers.Delete

Click to remove all the DID numbers displayed on the page.Replace this list
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SIP Trunks Field Descriptions

Turn on the slider to configure SIP trunks.

Choose your provider from the "Provider Template" or use "Custom". To have a new provider added as
template, or to request assistance, contact the dedicated SIP Support Team. Do not open a TAC case as they
will not be able to assist you.

Note

Service Settings Field Descriptions

DescriptionField

Choose a service name from the drop-down list. The service names added in the
Direct Inward Dial (DID) Numbers page are listed in the drop-down.

Service Name

Choose a preconfigured provider template based on your SIP service provider.
If your SIP service provider is not in the drop-down list, choose "Custom".

Provider Template

Interface Settings Field Descriptions

DescriptionsField

Choose the type of interface connectivity for SIP trunk. Primary interface refers
to GE 0/0/0 and Secondary interface refers to GE 0/0/1. Primary interface is
always connected to the internet service provider. If the internet service provider
and SIP trunk service provider are different, use secondary interface for SIP trunk
connectivity.

• Proxy Server Field Descriptions—SIP trunk and internet connectivity is
provided by the same service provider.

• Secondary Interfacewith Static Address—SIP trunk and internet are provided
by two separate service providers. Internet service provider is connected
using the primary interface and SIP trunk service provider is connected using
the secondary interface. The SIP trunk service provider provides static IP
address for the network connectivity.

• Secondary Interface with Dynamic Address—SIP trunk and internet are
provided by two separate service providers. Internet service provider is
connected using the primary interface and SIP trunk service provider is
connected using the secondary interface. The SIP trunk service provider
provides dynamic IP address for the network connectivity.

Use Secondary Interface
for Trunk?

Enter the public IP address assigned by your internet service provider so that SIP
services work across Network Address Translation (NAT).

External Public Address
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No Secondary Interface

Proxy Server Field Descriptions

DescriptionField

Enter an IP address and Port, Fully Qualified Domain Name (FQDN) and Port,
or SRV record for your service proxy.

Enter a unique address that does not overlap with the address that is
assigned for Gig 0/0/0 interface, Gig 0/0/1 interface, and SMTP server.

Note

Proxy Address

Optional. If you have provided an IP address for the proxy, you may also specify
a non-standard SIP port if necessary. Leave blank to use port 5060.

Proxy Port

Outbound Proxy

Enter an IP Address, fully qualified domain name, or domain SRV for your
service outbound proxy if one is used.

Enter a unique address that does not overlap with the address that is
assigned for Gig 0/0/0 interface, Gig 0/0/1 interface, and SMTP server.

Note

Outbound Proxy Address

Optional. If you have provided an IP address for the outbound proxy, you may
also specify a non-standard SIP port if necessary. Leave blank to use port 5060.

Outbound Proxy Port

Call Authentication

Enter the username and password if your service provider requires authentication
for every call.

Username and Password

Enter the authentication realm for call authentication. Typically, authentication
realm is the service domain name.

Authentication Realm

Check the "Include in Invite" check box, if your service provider requires
authentication details to be sent in the initial invite. If unchecked, authentication
is provided in the response to a 407 challenge.

Include in Invite

Proxy Server—Advanced Options Field Descriptions

DescriptionField

Enter the minimum value for the session expiry parameter sent in the initial invite.
Range is from 90 to 86,400 seconds. Unless instructed by your SIP service
provider, the default value of 90 seconds must be used.

Min-SE

Enter the maximum duration of a session in seconds. During a call, the session
expiry time is periodically refreshed based on the value entered here. Range is
from 90 to 86,400 seconds. Unless instructed by your provider, the default value
of 1800 seconds should be used.

Session Expires

Limit the range of ports used for RTP. Enter even numbers between 8,000 to
48,198.

RTP Port Range
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DescriptionField

Choose the protocol used for transport layer by your service provider.Transport Layer

Choose one of the ITU-T T.38 standard Fax Transmission Protocols to be used
for a specific VoIP dial peer. Available options are:

• T.38

• T.38 fall back to G.711 u-law

• T.38 fall back to G.711 a-law

• Pass Through G711u

• Pass Through G711a

Fax Transmission
Protocol

Choose one of the following as the DTMF signaling mechanism based on the
protocol offered by your SIP service provider.

• RFC2833

• sip-notify

DTMFSignaling Protocol

Choose one of the following for calling party header selection:

• From

• Remote Party ID (RPID)

• P-AID Pilot DID

• P-AID Assigned DIDs

Calling Party Header
Selection

Leave the "Calling Party Domain" field blank to send the BE4000 IP address
with calling party headers. Enter a domain name or full qualified domain if you
want to replace the BE4000 IP address.

Calling Party Domain

"Pilot Number" field is displayed only when "Calling Party Header
Selection" drop-down is chosen as "P-AID Pilot DID".

Note

Choose the "Pilot Number" from the drop-down list if the service provider requires
a specific number to be used for P-Asserted Identity Headers.

Pilot Number

Enter the dialing prefix if the service provider allows calling line ID to be withheld
on a call by call basis.

CLI Restriction Prefix

Uncheck the "RFC3555 Compliant G.729 Annex B" check box if the call server
is not RFC3555 compliant for G.729AnnexB SDP formatting (Adds g729-annexb
override). Check if you are unsure.

RFC3555 Compliant
G.729 Annex B

Check the "Two way media override" check box to override modification of
media stream from send/receive to sendonly or inactive.When checked, two way
media is always be requested.

Two way media override
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DescriptionField

Check the Redirection option to reset the default processing of 3xx messages.
By default, SIP gateways process all incoming 3xx redirect messages according
to RFC 2543. However if the Redirection option is disabled, the gateway treats
the incoming 3xx responses as 4xx error class responses.

Redirection should be selected by default and only unselected if required by the
SIP trunk provider.

Redirection (Optional)

Options Ping

Enable to monitor the SIP service availability allowing traffic to be rerouted, if possible, in the event of
failure.

Enter the period between Options packets being sent while the service is
considered to be up. Range is from 5 to 1,200 seconds. Default is 60 seconds.

Service Up Interval

Enter the period between Options packets being sent while the service is
considered to be down. Range is from 5 to 1,200 seconds. Default is 30 seconds.

Service Down Interval

Enter the number of missed responses allowed before a service is considered
unavailable. Range is from 1 to 10. Default is 5.

Retries

Registrar Server

Registrar server can be configured either through DHCP or by providing IP address and port. Click one of
the following options based on your network:

• Configure via DHCP

• Configure address and port

Registrar Server Field Descriptions

DescriptionField

Enter an IP Address, fully qualified domain name, or domain SRV for service
registrar.

This field appears only when you choose Configure address and port.

Enter a unique address that does not overlap with the address that is
assigned for Gig 0/0/0 interface, Gig 0/0/1 interface, and SMTP server.

Note

Registrar Address

If you have provided an IP address for the registrar, you may also specify a
non-standard SIP port if necessary. Leave blank to use port 5060.

This field appears only when you choose Configure address and port.

Registrar Port

Enter the authentication realm used for registration by your service provider.
Mandatory if Registrar Address or DHCP is configured.

Authentication Realm

Check the "Registrar with Realm" configuring the registrar with the realm
information provided for the proxy. Uncheck to remove the configuration.

Registrar with realm
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DescriptionField

Enter the username and password, if the service provider requires per call
authentication.

Username and Password

Select appropriate DID for each username if the service provider requires a DID
to be included with registration authentication.

Include DID

Click to add multiple rows for username, password, and include DID. You can
add a maximum of 98 rows.

Add Row

Registrar Server—Advanced Options Field Descriptions

DescriptionField

Enter the Registration Timeout period. Determines how frequently the system
registers.

Registration Timeout

Choose TCP or UDP from the "Transport Layer" drop-down list as the transport
protocol used by the service provider.

Transport Layer

Security

Add at least one trusted IP Address. The BE4000 accepts incoming VoIP (SIP) calls only if the remote IP
address of an incoming VoIP call matches an address in the trusted IP address list. Enter the IP addresses
provided for proxy, outbound proxy, and registrar from your service provider. IP addresses must be provided
if hostnames are used. Entries can be provided either as a host address (x.x.x.x) or subnet (x.x.x.x /nn)."

Security Field Descriptions

DescriptionField

Enter a trusted IP address to authenticate incoming SIP trunk calls for toll fraud
prevention.

Trusted IP Address

Click "Add Row" and enter the trusted IP addresses.Add Row
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Secondary Interface with Static Address

Interface Settings

DescriptionField

Ethernet ports usually use the auto-negotiate protocol settings. If your switch
does not support this option by itself, choose from the following interface options:

• Auto Negotiate

• Gigabit Ethernet

• Fast Ethernet Full Duplex

• Fast Ethernet Half Duplex

• Ethernet Full Duplex

• Ethernet Half Duplex

By default, Auto Negotiate is selected.Note

Interface Options

Enter IP address and subnet mask of the secondary interface. The fields are
mandatory.

IP Address and Mask

Enter the IP address of the default gateway. This field is mandatory.Default Gateway

Enter the IP address of the dedicated, private DNS used by your service provider.
Ensure that you enter the name server addresses even if they are provided via
DHCP. You can enter a maximum of 6 IP addresses separated by spaces.

Name Servers

Enter To ensure that SIP services work across Network Address Translation,
provide the public IP address provided by your service provider.

External Public Address

Proxy Server Field Descriptions

DescriptionField

Enter an IP address and Port, Fully Qualified Domain Name (FQDN) and Port,
or SRV record for your service proxy.

Enter a unique address that does not overlap with the address that is
assigned for Gig 0/0/0 interface, Gig 0/0/1 interface, and SMTP server.

Note

Proxy Address

Optional. If you have provided an IP address for the proxy, you may also specify
a non-standard SIP port if necessary. Leave blank to use port 5060.

Proxy Port

Outbound Proxy

Enter an IP Address, fully qualified domain name, or domain SRV for your
service outbound proxy if one is used.

Enter a unique address that does not overlap with the address that is
assigned for Gig 0/0/0 interface, Gig 0/0/1 interface, and SMTP server.

Note

Outbound Proxy Address
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DescriptionField

Optional. If you have provided an IP address for the outbound proxy, you may
also specify a non-standard SIP port if necessary. Leave blank to use port 5060.

Outbound Proxy Port

Call Authentication

Enter the username and password if your service provider requires authentication
for every call.

Username and Password

Enter the authentication realm for call authentication. Typically, authentication
realm is the service domain name.

Authentication Realm

Check the "Include in Invite" check box, if your service provider requires
authentication details to be sent in the initial invite. If unchecked, authentication
is provided in the response to a 407 challenge.

Include in Invite

Proxy Server—Advanced Options Field Descriptions

DescriptionField

Enter the minimum value for the session expiry parameter sent in the initial invite.
Range is from 90 to 86,400 seconds. Unless instructed by your SIP service
provider, the default value of 90 seconds must be used.

Min-SE

Enter the maximum duration of a session in seconds. During a call, the session
expiry time is periodically refreshed based on the value entered here. Range is
from 90 to 86,400 seconds. Unless instructed by your provider, the default value
of 1800 seconds should be used.

Session Expires

Limit the range of ports used for RTP. Enter even numbers between 8,000 to
48,198.

RTP Port Range

Choose the protocol used for transport layer by your service provider.Transport Layer

Choose one of the ITU-T T.38 standard Fax Transmission Protocols to be used
for a specific VoIP dial peer. Available options are:

• T.38

• T.38 fall back to G.711 u-law

• T.38 fall back to G.711 a-law

• Pass Through G711u

• Pass Through G711a

Fax Transmission
Protocol

Choose one of the following as the DTMF signaling mechanism based on the
protocol offered by your SIP service provider.

• RFC2833

• sip-notify

DTMFSignaling Protocol
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DescriptionField

Choose one of the following for calling party header selection:

• From

• Remote Party ID (RPID)

• P-AID Pilot DID

• P-AID Assigned DIDs

Calling Party Header
Selection

Leave the "Calling Party Domain" field blank to send the BE4000 IP address
with calling party headers. Enter a domain name or full qualified domain if you
want to replace the BE4000 IP address.

Calling Party Domain

"Pilot Number" field is displayed only when "Calling Party Header
Selection" drop-down is chosen as "P-AID Pilot DID".

Note

Choose the "Pilot Number" from the drop-down list if the service provider requires
a specific number to be used for P-Asserted Identity Headers.

Pilot Number

Enter the dialing prefix if the service provider allows calling line ID to be withheld
on a call by call basis.

CLI Restriction Prefix

Uncheck the "RFC3555 Compliant G.729 Annex B" check box if the call server
is not RFC3555 compliant for G.729AnnexB SDP formatting (Adds g729-annexb
override). Check if you are unsure.

RFC3555 Compliant
G.729 Annex B

Check the "Two way media override" check box to override modification of
media stream from send/receive to sendonly or inactive.When checked, two way
media is always be requested.

Two way media override

Check the "Redirection (Optional)" to reset the default processing of 3xx
messages. By default, SIP gateways process all incoming 3xx redirect messages
according to RFC 2543. However if the Redirection option is disabled, the gateway
treats the incoming 3xx responses as 4xx error class responses.

Redirection should be selected by default and only unselected if required by the
SIP trunk provider.

Redirection (Optional)

Options Ping

Enable to monitor the SIP service availability allowing traffic to be rerouted, if possible, in the event of
failure.

Enter the period between Options packets being sent while the service is
considered to be up. Range is from 5 to 1,200 seconds. Default is 60 seconds.

Service Up Interval

Enter the period between Options packets being sent while the service is
considered to be down. Range is from 5 to 1,200 seconds. Default is 30 seconds.

Service Down Interval

Enter the number of missed responses allowed before a service is considered
unavailable. Range is from 1 to 10. Default is 5.

Retries
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Registrar Server

Registrar server can be configured either through DHCP or by providing IP address and port. Click one of
the following options based on your network:

• Configure via DHCP

• Configure address and port

Registrar Server Field Descriptions

DescriptionField

Enter an IP Address, fully qualified domain name, or domain SRV for service
registrar.

This field appears only when you choose Configure address and port.

Enter a unique address that does not overlap with the address that is
assigned for Gig 0/0/0 interface, Gig 0/0/1 interface, and SMTP server.

Note

Registrar Address

If you have provided an IP address for the registrar, you may also specify a
non-standard SIP port if necessary. Leave blank to use port 5060.

This field appears only when you choose Configure address and port.

Registrar Port

Enter the authentication realm used for registration by your service provider.
Mandatory if Registrar Address or DHCP is configured.

Authentication Realm

Check the "Registrar with Realm" configuring the registrar with the realm
information provided for the proxy. Uncheck to remove the configuration.

Registrar with realm

Enter the username and password, if the service provider requires per call
authentication.

Username and Password

Choose appropriate DID for each username if the service provider requires a DID
to be included with registration authentication.

Include DID

Click to add multiple rows for username, password, and include DID. You can
add a maximum of 98 rows.

Add Row

Registrar Server—Advanced Options Field Descriptions

DescriptionField

Enter the Registration Timeout period. Determines how frequently the system
registers.

Registration Timeout

Choose TCP or UDP from the "Transport Layer" drop-down list as the transport
protocol used by the service provider.

Transport Layer
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Security

Add at least one trusted IP Address. The BE4000 accepts incoming VoIP (SIP) calls only if the remote IP
address of an incoming VoIP call matches an address in the trusted IP address list. Enter the IP addresses
provided for proxy, outbound proxy, and registrar from your service provider. IP addresses must be provided
if hostnames are used. Entries can be provided either as a host address (x.x.x.x) or subnet (x.x.x.x /nn)."

Security Field Descriptions

DescriptionField

Enter a trusted IP address to authenticate incoming SIP trunk calls for toll fraud
prevention.

Trusted IP Address

Click "Add Row" and enter the trusted IP addresses.Add Row

Secondary Interface with Dynamic Address

Interface Settings

DescriptionField

Ethernet ports usually use the auto-negotiate protocol settings. If your switch
does not support this option by itself, choose from the following interface options:

• Auto Negotiate

• Gigabit Ethernet

• Fast Ethernet Full Duplex

• Fast Ethernet Half Duplex

• Ethernet Full Duplex

• Ethernet Half Duplex

By default, Auto Negotiate is selected.Note

Interface Options

Enter the IP address of the dedicated, private DNS used by your service provider.
Ensure that you enter the name server addresses even if they are provided via
DHCP. You can enter a maximum of 6 IP addresses separated by spaces.

Name Servers

Enter To ensure that SIP services work across Network Address Translation,
provide the public IP address provided by your service provider.

External Public Address
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Proxy Server Field Descriptions

DescriptionField

Enter an IP address and Port, Fully Qualified Domain Name (FQDN) and Port,
or SRV record for your service proxy.

Enter a unique address that does not overlap with the address that is
assigned for Gig 0/0/0 interface, Gig 0/0/1 interface, and SMTP server.

Note

Proxy Address

Optional. If you have provided an IP address for the proxy, you may also specify
a non-standard SIP port if necessary. Leave blank to use port 5060.

Proxy Port

Outbound Proxy

Enter an IP Address, fully qualified domain name, or domain SRV for your
service outbound proxy if one is used.

Enter a unique address that does not overlap with the address that is
assigned for Gig 0/0/0 interface, Gig 0/0/1 interface, and SMTP server.

Note

Outbound Proxy Address

Optional. If you have provided an IP address for the outbound proxy, you may
also specify a non-standard SIP port if necessary. Leave blank to use port 5060.

Outbound Proxy Port

Call Authentication

Enter the username and password if your service provider requires authentication
for every call.

Username and Password

Enter the authentication realm for call authentication. Typically, authentication
realm is the service domain name.

Authentication Realm

Check the "Include in Invite" check box, if your service provider requires
authentication details to be sent in the initial invite. If unchecked, authentication
is provided in the response to a 407 challenge.

Include in Invite

Proxy Server—Advanced Options Field Descriptions

DescriptionField

Enter the minimum value for the session expiry parameter sent in the initial invite.
Range is from 90 to 86,400 seconds. Unless instructed by your SIP service
provider, the default value of 90 seconds must be used.

Min-SE

Enter the maximum duration of a session in seconds. During a call, the session
expiry time is periodically refreshed based on the value entered here. Range is
from 90 to 86,400 seconds. Unless instructed by your provider, the default value
of 1800 seconds should be used.

Session Expires

Limit the range of ports used for RTP. Enter even numbers between 8,000 to
48,198.

RTP Port Range

Choose the protocol used for transport layer by your service provider.Transport Layer
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DescriptionField

Choose one of the ITU-T T.38 standard Fax Transmission Protocols to be used
for a specific VoIP dial peer. Available options are:

• T.38

• T.38 fall back to G.711 u-law

• T.38 fall back to G.711 a-law

• Pass Through G711u

• Pass Through G711a

Fax Transmission
Protocol

Choose one of the following as the DTMF signaling mechanism based on the
protocol offered by your SIP service provider.

• RFC2833

• sip-notify

DTMFSignaling Protocol

Choose one of the following for calling party header selection:

• From

• Remote Party ID (RPID)

• P-AID Pilot DID

• P-AID Assigned DIDs

Calling Party Header
Selection

Leave the "Calling Party Domain" field blank to send the BE4000 IP address
with calling party headers. Enter a domain name or full qualified domain if you
want to replace the BE4000 IP address.

Calling Party Domain

"Pilot Number" field is displayed only when "Calling Party Header
Selection" drop-down is chosen as "P-AID Pilot DID".

Note

Choose the "Pilot Number" from the drop-down list if the service provider requires
a specific number to be used for P-Asserted Identity Headers.

Pilot Number

Enter the dialing prefix if the service provider allows calling line ID to be withheld
on a call by call basis.

CLI Restriction Prefix

Uncheck the "RFC3555 Compliant G.729 Annex B" check box if the call server
is not RFC3555 compliant for G.729AnnexB SDP formatting (Adds g729-annexb
override). Check if you are unsure.

RFC3555 Compliant
G.729 Annex B

Check the "Two way media override" check box to override modification of
media stream from send/receive to sendonly or inactive.When checked, two way
media is always be requested.

Two way media override
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DescriptionField

Check the "Redirection (Optional)" to reset the default processing of 3xx
messages. By default, SIP gateways process all incoming 3xx redirect messages
according to RFC 2543. However if the Redirection option is disabled, the gateway
treats the incoming 3xx responses as 4xx error class responses.

Redirection should be selected by default and only unselected if required by the
SIP trunk provider.

Redirection (Optional)

Options Ping

Enable to monitor the SIP service availability allowing traffic to be rerouted, if possible, in the event of
failure.

Enter the period between Options packets being sent while the service is
considered to be up. Range is from 5 to 1,200 seconds. Default is 60 seconds.

Service Up Interval

Enter the period between Options packets being sent while the service is
considered to be down. Range is from 5 to 1,200 seconds. Default is 30 seconds.

Service Down Interval

Enter the number of missed responses allowed before a service is considered
unavailable. Range is from 1 to 10. Default is 5.

Retries

Registrar Server

Registrar server can be configured either through DHCP or by providing IP address and port. Click one of
the following options based on your network:

• Configure via DHCP

• Configure address and port

Registrar Server Field Descriptions

DescriptionField

Enter an IP Address, fully qualified domain name, or domain SRV for service
registrar.

This field appears only when you choose Configure address and port.

Enter a unique address that does not overlap with the address that is
assigned for Gig 0/0/0 interface, Gig 0/0/1 interface, and SMTP server.

Note

Registrar Address

If you have provided an IP address for the registrar, you may also specify a
non-standard SIP port if necessary. Leave blank to use port 5060.

This field appears only when you choose Configure address and port.

Registrar Port

Enter the authentication realm used for registration by your service provider.
Mandatory if Registrar Address or DHCP is configured.

Authentication Realm

Check the "Registrar with Realm" configuring the registrar with the realm
information provided for the proxy. Uncheck to remove the configuration.

Registrar with realm
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DescriptionField

Enter the username and password, if the service provider requires per call
authentication.

Username and Password

Choose appropriate DID for each username if the service provider requires a DID
to be included with registration authentication.

Include DID

Click to add multiple rows for username, password, and include DID. You can
add a maximum of 98 rows.

Add Row

Registrar Server—Advanced Options Field Descriptions

DescriptionField

Enter the Registration Timeout period. Determines how frequently the system
registers.

Registration Timeout

Choose TCP or UDP from the "Transport Layer" drop-down list as the transport
protocol used by the service provider.

Transport Layer

Security

Add at least one trusted IP Address. The BE4000 accepts incoming VoIP (SIP) calls only if the remote IP
address of an incoming VoIP call matches an address in the trusted IP address list. Enter the IP addresses
provided for proxy, outbound proxy, and registrar from your service provider. IP addresses must be provided
if hostnames are used. Entries can be provided either as a host address (x.x.x.x) or subnet (x.x.x.x /nn)."

Security Field Descriptions

DescriptionField

Enter a trusted IP address to authenticate incoming SIP trunk calls for toll fraud
prevention.

Trusted IP Address

Click "Add Row" and enter the trusted IP addresses.Add Row

Line Cards Field Descriptions

BE4000 allows you to connect to traditional telephony services and devices by adding Network Interface
Modules (NIM). You can add a maximum of two NIM cards. For the list of supported NIM cards, refer
Supported Line Cards.

Turn on the slider for the NIM cardslot where you want to insert the NIM card.

DescriptionField

Select the NIM card as per your connectivity requirements.NIM 1

Select the NIM card as per your connectivity requirements.NIM 2
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NIM-2FXS or NIM-4FXS

DescriptionField

If you are using NIM-2FXS or NIM-4FXS, input the following details:

Choose one of the following:

• Disabled—The line is inactive.

• Analog Phone—The line is connected to an analog phone.

• Paging—The line is connected to an external paging system.

• Automatic Ringdown—The line is connected to a phone that has a dedicated
connection with another phone. When the phone connected to this line goes
off hook, the destination phone rings. There is no need to dial any number.

Type

Enter the label to identify each line.Label

Enter the extension number.Extension

This field is visible only when you choose "Automatic Ringdown"
from the Type drop-down list.

Note

Enter the extension of the destination phone that rings when the phone goes off
hook.

Destination

Choose one of the following Class of Restriction (COR):

• internal

• local

• local-plus

• national

• national-plus

• international

Class of Restriction decides the type of calls that can be placed from the FXS
phone line.

Note • You must select the Class of Restriction (COR) for every line
while adding FXS cards in the Setup Assistant.

• This field is available only when you chooseAnalog Phone from
the "Type" drop-down list.

Restrictions

Choose the type of algorithm used for modifying an input signal for digitization:

• u-law

• a-law

Law
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DescriptionField

The amount of amplification or deamplification of sound in terms of decibels.
Range is from -6 to 14 db. Default value for FXO line is 0 db and for FXS line
is 6 db.

This field is available only while editing the line cards containing FXS
and FXO lines. This field does not appear while adding the line card
during initial site deployment (in the Setup Assistant wizard) or post
site deployment (under Manage Site > Line Cards (NIM) > Add NIM
Card).

Note

Input Gain (db)

The value that is configured for minimizing the signal loss. Range is from -6 to
14 db. Default value for FXO and FXS line is 0 db.

This field is available only while editing the line cards containing FXS
and FXO lines. This field does not appear while adding the line card
during initial site deployment (in the Setup Assistant wizard) or post
site deployment (under Manage Site > Line Cards (NIM) > Add NIM
Card).

Note

Output Attenuation (db)

NIM-2FXO or NIM-4FXO

DescriptionField

If you are using NIM-2FXO or NIM-4FXO, input the following details:

Choose one of the following:

• Disabled—The line is inactive.

• Trunk—The line is connected to the Public Switched Telephone Network.

• Paging—The line is connected to an external paging system.

Type

Enter the label name.Label

This field appears only when "Trunk" is chosen from the "Type"
drop-down list.

Note

Enter a name for the trunk line.

Name

Enter the number for analog phone line.Extension

This field appears only when "Trunk" is chosen from the "Type"
drop-down list.

Note

Enter the number for the trunk line.

Number

Choose one of the following:

• Ground

• Loop Start

Start Type
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DescriptionField

Mark the line as incoming only or bidirectional. The system builds the trunk
groups based on what you select.

• In + Out—Allows the phone line to receive and make calls.

• Inbound Only—Allows the phone line to receive the calls.

Direction

Choose the type of algorithm used for modifying an input signal for digitization:

• u-law

• a-law

Law

The amount of amplification or deamplification of sound in terms of decibels.
Range is from -6 to 14 db. Default value for FXO line is 0 db and for FXS line
is 6 db.

This field is available only while editing the line cards containing FXS
and FXO lines. This field does not appear while adding the line card
during initial site deployment (in the Setup Assistant wizard) or post
site deployment (under Manage Site > Line Cards (NIM) > Add NIM
Card).

Note

Input Gain (db)

The value that is configured for minimizing the signal loss. Range is from -6 to
14 db. Default value for FXO and FXS line is 0 db.

This field is available only while editing the line cards containing FXS
and FXO lines. This field does not appear while adding the line card
during initial site deployment (in the Setup Assistant wizard) or post
site deployment (under Manage Site > Line Cards (NIM) > Add NIM
Card).

Note

Output Attenuation (db)

Displays the advanced fields.Show Advanced

Configuration Voice Port Commands

The following fields are displayed only when the Show Advanced check box is checked.Note

Enables or disables cable polling on an analog Foreign Exchange Office (FXO)
port.

Cable Detect

Configuring "Bearer Capability" drop-down list does not have any
affect on the FXO port.

Note

Specifies the information transfer capability of the bearer capability information
element (IE) in the outgoing ISDNSETUPmessage for Session Initiation Protocol
(SIP) early-media calls. You can choose one of the following:

• Speech—Specifies speech as the information transfer capability.

• 3100hz—Specifies 3.1 kHz audio as the information transfer capability.

Bearer Capability
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DescriptionField

Configures the type of supervisory disconnect signaling available on the FXO
port. When the supervisory disconnect tone is detected on the FXO port, the
system interprets this as a disconnect indication from the switch and clears the
call. Choose one of the following:

• dualtone—Disconnects calls when the router detects call-progress tones
from a PBX or the PSTN.

• anytone—Disconnects the call if the PBX or PSTN does not provide a
supervisory tone. Examples of tones that trigger a disconnect include busy
tone, fast busy tone, and dial tone.

• signal—Enables a disconnect indication by detecting the power denial which
uses the LCFO signal on the remote end.

Supervisory Disconnect

Time-outs

Specifies when to disconnect the call. You can choose one of the following:

• timer—Specifies the duration to wait while the phone is ringing before
disconnecting the call. Range is from 0 to 120 seconds.

• infinity—Disables disconnect supervision. The voice port does not disconnect
when a disconnect tone is detected.

Call Disconnect

Specifies the number of seconds for which the systemwaits for the caller to input
the first digit of the dialed digits. Range is from 0 to 120 seconds.

Initial Timeout

Configuring Power Denial drop-down list does not have affect on the
FXO port.

Note

Sets the duration of the power denial that the voice gateway applies to the FXS
port when a call disconnects. Range is from 0 to 2500 seconds.

Power Denial

Limits the time a voice port can be held in a call failure state. After the timeout,
the release sequence is enabled. You can choose one of the following:

• timer—Range is from 1 to 3600 seconds.

• infinity—The voice port is never released as long as the call-failure state
remains.

Wait Release

NIM-2FXS/4FXO

DescriptionField

If you are using NIM-2FXS/4FXO, input the following details:

FXS
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DescriptionField

Choose one of the following:

• Disabled—The line is inactive.

• Analog Phone—The line is connected to an analog phone.

• Paging—The line is connected to an external paging system.

• Automatic Ringdown—The line is connected to a phone that has a dedicated
connection with another phone. When the phone connected to this line goes
off hook, the destination phone rings. There is no need to dial any number.

Type

Enter the label to identify each line.Label

Enter the extension number.Extension

This field is visible only when you choose "Automatic Ringdown"
from the Type drop-down list.

Note

Enter the extension of the destination phone that rings when the phone goes off
hook.

Destination

Choose one of the following Class of Restriction (COR):

• internal

• local

• local-plus

• national

• national-plus

• international

Class of Restriction decides the type of calls that can be placed from the FXS
phone line.

Note • You must select the Class of Restriction (COR) for every line
while adding FXS cards in the Setup Assistant.

• This field is available when you choose Analog Phone from the
"Type" drop-down list.

Restrictions

Choose the type of algorithm used for modifying an input signal for digitization:

• u-law

• a-law

Law
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DescriptionField

The amount of amplification or deamplification of sound in terms of decibels.
Range is from -6 to 14 db. Default value for FXO line is 0 db and for FXS line
is 6 db.

This field is available only while editing the line cards containing FXS
and FXO lines. This field does not appear while adding the line card
during initial site deployment (in the Setup Assistant wizard) or post
site deployment (under Manage Site > Line Cards (NIM) > Add NIM
Card).

Note

Input Gain (db)

The value that is configured for minimizing the signal loss. Range is from -6 to
14 db. Default value for FXO and FXS line is 0 db.

This field is available only while editing the line cards containing FXS
and FXO lines. This field does not appear while adding the line card
during initial site deployment (in the Setup Assistant wizard) or post
site deployment (under Manage Site > Line Cards (NIM) > Add NIM
Card).

Note

Output Attenuation (db)

FXO

Choose one of the following:

• Disabled—The line is inactive.

• Trunk—The line is connected to the Public Switched Telephone Network.

• Paging—The line is connected to an external paging system.

Type

Enter the label name.Label

This field appears only when "Trunk" is chosen from the "Type"
drop-down list.

Note

Enter a name for the trunk line.

Name

Enter the number for analog phone line.Extension

This field appears only when "Trunk" is chosen from the "Type"
drop-down list.

Note

Enter the number for the trunk line.

Number

Choose one of the following:

• Ground

• Loop Start

Start Type
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DescriptionField

Mark the line as incoming only or bidirectional. The system builds the trunk
groups based on what you select.

• In + Out—Allows the phone line to receive and make calls.

• Inbound Only—Allows the phone line to receive the calls.

Direction

Choose the type of algorithm used for modifying an input signal for digitization:

• u-law

• a-law

Law

The amount of amplification or deamplification of sound in terms of decibels.
Range is from -6 to 14 db. Default value for FXO line is 0 db and for FXS line
is 6 db.

This field is available only while editing the line cards containing FXS
and FXO lines. This field does not appear while adding the line card
during initial site deployment (in the Setup Assistant wizard) or post
site deployment (under Manage Site > Line Cards (NIM) > Add NIM
Card).

Note

Input Gain (db)

The value that is configured for minimizing the signal loss. Range is from -6 to
14 db. Default value for FXO and FXS line is 0 db.

This field is available only while editing the line cards containing FXS
and FXO lines. This field does not appear while adding the line card
during initial site deployment (in the Setup Assistant wizard) or post
site deployment (under Manage Site > Line Cards (NIM) > Add NIM
Card).

Note

Output Attenuation (db)

NIM-2BRI-NT/TE or NIM-4BRI-NT/TE

DescriptionField

If you are using NIM-2BRI-NT/TE or NIM-4BRI-NT/TE, input the following details:

Choose one of the following:

• Disabled—The line is inactive.

• Trunk—The line is connected to the Public Switched Telephone Network.

Type

Choose a service name from the drop-down list. The drop-down list contains the
list of service providers that you added in the DID page. Service name entered
here is shared across all the lines or ports for the selected NIM type.

You cannot choose the same service provider for SIP and Line Cards.Note

Service Name
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DescriptionField

If your service provider requires that your line use a static Terminal Endpoint
Identifier, enter the value between 0 and 63. If the field is left blank, the line
attempt to negotiate a TEI.

Static TEI

Choose whether you want your call setup to work based on overlap receiving.
You can enable or disable this option. If your service provider does not use
“enbloc” signaling, this option allows BE4000 to wait for additional digits to be
received before the call is routed.

Overlap Receiving

Check the "Send Redirecting IE Number" check box to include the Redirecting
Number Information Element in the outbound Setupmessages. Leave unchecked
if you are not sure about your service provider supporting this feature.

Send Redirecting IE
Number

Enter the ISDN SPID. Some service providers use service profile identifiers
(SPIDs) to define the services subscribed to by the ISDN device that is accessing
the ISDN service provider. A SPID is usually a seven-digit phone number with
some optional numbers.

ISDN SPID

Choose amethod for TEI negotiation based on your service provider requirements.
Setting a static TEI overrides TEI negotiation.

The default behavior is TEI to be negotiated on power-up. The following options
are provided to preserve or remove a negotiated TEI when the interface is reset:

• Power Up and Remove

• Power Up and Preserve

• First Call and Remove

• First Call and Preserve

TEI Negotiation Method

NIM-1MFT-T1/E1, NIM-2MFT-T1/E1, or NIM-4MFT-T1/E1

DescriptionField

If you choose NIM-1MFT-T1/E1, NIM-2MFT-T1/E1, or NIM-4MFT-T1/E1, enter the following details:

Choose the card type based on your customer network requirement. E1 PRI is
chosen by default. The available options are:

• T1 PR1

• E1 PRI

Card Type

Choose one of the following:

• Disabled—The line is inactive.

• Trunk—The line is connected to the Public Switched Telephone Network.

Type
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DescriptionField

Choose a service name from the drop-down list. The drop-down list contains the
list of service providers that you added in the DID page. Service name entered
here is shared across all the lines or ports for the selected NIM type.

You cannot choose the same service provider for SIP and Line Cards.Note

Service Name

Choose one of the following ISDN Service Provider PRI Switch Types:

• primary-4ess

• primary-5ess

• dms100

• primary-net5

• primary-ni

“primary-4ess” is chosen by default.

ISDN Switch Type

Defines the controller setup for configuring channelized T1 or E1 controllers.
Choose either Full PRI or partial PRI.

Controller Setup

Choose a line code. By default, the line code for E1 PRI is high-density bipolar
3 (hdb3).

Line Code

Choose the framing from the drop-down list. This option defines the framing
characteristics.

Framing

Check the "Send Redirecting IE Number" check box to include the Redirecting
Number Information Element in the outbound Setupmessages. Leave unchecked
if you are not sure about your service provider supporting this feature.

Send Redirecting IE
Number

Private IP Ranges

IP addresses used for provisioning the phones must be allowed in RFC 1918 (10.0.0.8 /16, 172.16.0.0 /12,
192.168.0.0 /16). If the IP address that is used for provisioning phone is other than the ones allowed in RFC
1918, the phone provisioning fails. To avoid such phone provisioning issues, you must enter the IP addresses
in the Private IP Ranges page. You can add individual IP address (host address) in the x.x.x.x format or an
IP address range (subnet) in the x.x.x.x /n format.

Click Add Row and add private IP address ranges one by one.

Dial Plan Field Descriptions
Region Settings Field Descriptions

DescriptionField

Choose your home country. This is used to display the date, time, currency, and
other dial plan tones and numbers.

Telephony Port Tones
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DescriptionField

Choose your relevant time zone. Typically, your time zone is linked to the area
code of your main company number. For example, for area code 919 (RTP),
the time zone defaults to Pacific Time.

Time Zone

Choose your phone display language as the default language used for all accounts
and notifications from the drop-down list.

Phone Display Language

Select the country to define dial tone for your phones.Phone Tones

Select the language in which you want to receive your phone greetings.Voicemail and System
Prompt Language

Select the language preference for your customers self care portal.Selfcare Portal

Select the time format as 12-or 24 hour. For example, the default format for the
United States is 12 hours.

Time Format

Select the date format to suit your needs. For example, the default format for
the United States is MM/DD/YY.

Date Format

Enables or disables the automatic adjustment of daylight saving time on your
phones.

DST Auto Adjust

Dial Plans Field Descriptions

DescriptionField

Choose the country and locale that you want for your
system.

Country

Select the option for local dialing as per customer
requirement. The local area length value depends on
the regulation set up by the service providers in your
region.

Local Dialling Options

Enter a valid “Local Area Code” for your main
number. This field appears based on the local dialing
option selected.

Local Area Code
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DescriptionField

Choose the class of restriction for the dialing patterns
belonging to a dial plan. Choose one of the following
options from the drop-down list for COR column:

• internal

• local

• local-plus

• national

• national-plus

• international

COR

Choose the preference for the selected dialing patterns
belonging to a dial plan. Choose one of the following
options from the drop-down list for Preference
column:

• POTSthenSIP

• SIPthenPOTS

• SIPOnly

• POTSOnly

The "Preference" is set to "SIPthenPOTS" by default.
The "Preference" for call-emergency patterns is set
to "POTSthenSIP" by default.

Preference

Stations Field Descriptions
Stations Field Descriptions

You can enter the user details in two ways:

• Click “Add Row” and add the user details one by one.

• Download the template that is provided on the screen. Fill in the details and upload all users' details in
one go.

Setup Assistant
29

Setup Assistant
Stations Field Descriptions



DescriptionField

Choose a type of user:

• User—An extension assigned to the user. You must configure an email address
associated with the user.

• Public—An extension assigned to a phone that is meant for general use by many
users. You need not configure an email address. For example, the extension assigned
to a phone in the conference room.

Type

Enter the first name of the user.First Name

Enter the last name of the user.Last Name

Enter the display name of the user. The name entered here is displayed on the phone
along with the extension number. You can enter a maximum of 12 characters.

Display Name

Enter the email address of the user. The top-level domain in the email address can
contain up to six characters.

Email address must not be more than 32 characters in length. Only letters,
numbers, and the characters underscore (_), dot (.), and dash (-) are allowed
in the user ID portion of the email address. Do not use spaces in the email
address.

Note

Email

Enter the extension number assigned to the user.

Note • Enter a minimum of 3 digits for an extension. Maximum number of
digits in an extension can go up to 5.

• You cannot create an extension with leading zero.

• The first digit of the extension cannot be the same as the digit used for
dialing an outside line, sending a call to voicemail automatically, and
dialing an intercom extension.

Extension

Choose the phone model associated with the extension. For the list of supported phone
models, refer to “Supported Phones” section in the Cisco Business Edition 4000 Release
Notes.

Phone Type

Choose the Class of Restriction (COR) for the extension. COR allows you to choose
one of the calling privileges:

• internal

• local

• local-plus

• national

• national-plus

• international

COR
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DescriptionField

Enable or disable voicemail functionality.Voicemail

Enter the Single Number Reach (SNR) number for an extension.

SNR allows you to answer the incoming calls on the desk phone or from amobile phone.
You can also swap active calls on a desk phone or at a remote destination without
disconnecting the call. You should include the area code and any additional digits that
are required to obtain an outside line prefix to your destination number. Example—If
9 is the digit to dial outside line, 1 is the country code, 555 is the area code, and 9999999
is the subscriber number, you must enter 915559999999.

SNR

Deletes an entry.Delete

Replace an exiting list with an entirely new list.Replace this list

Add more rows to populate the stations list.Add Row

Allows you to download a customized template. Template should be of .csv format.Download
Template

Call Routing Field Descriptions
Business Hours

Business hours are the hours during the day in which business is commonly conducted. BE4000 allows you
set weekly schedule for open hours and yearly holidays when the business is closed.

DescriptionField

Select one of the following options:

• 24/7 (No closed hours) - You can upload one audio file that is played for
all calls received during 24/7.

• Dual Hours (Open and Closed) - You can upload different audio files for
the calls received during open and closed hours.

Open Business Hours

When you select Dual Hours (Open and Closed), the following menu is displayed:

DescriptionField

Customize your business hours for your various departments. You can specify
the open hours for each day of the week.

Youmust enter time in 24-hour format only (17:00 for example). Time
must be either full (:00) or half hours (:30).

Note

Hours of Operation

Custom hours let you add and specify hours for each day of the week.Add Open Hours

Set up your holiday list.Holiday
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DescriptionField

Add the list of holidays for the organization.

Note • You can add holidays only for the current year and a year ahead.

• Date should not be less than the present date.

Add New Holiday

Hunt Group

Hunt Groups allow incoming calls to a specific number (pilot number) to be directed to a defined group of
extension numbers. Incoming calls are redirected from the pilot number to the first extension number as
defined in the configuration. If the first number is busy or does not answer, the call is redirected to the next
phone in the list. A call remains redirected on busy or no answer from number to number in the list until it is
answered or until the call reaches the number that is defined as the final number.

A Hunt Group can have static and dynamic members.

• Static Members—Permanent members belonging to the Hunt Group.

• Dynamic Members—Not the permanent members, but they can join or unjoin a Hunt Group on a need
basis using the softkeys available on the phone.

• You can add a maximum of 20 Hunt Groups.

• The total number of members in a Hunt Group, including static and dynamic members cannot exceed
32.

• If you check the "Allow dynamic members" check box on theHunt Groups page, ensure that you check
the "Hunt Group Login" check box for each dynamicmember extension underManage Site > Extensions
> Basic Info page.

• Once a Hunt Group is created, you cannot modify the Hunt Method. You have to delete and readd the
Hunt Group to modify the Hunt Method.

Note

Hunt Group Field Descriptions

Suggestions for Setting Up Hunt Group Timers

The Hunt Group page does not load any default values. You must set the values for the following fields based
on the selected Hunt Method.

• Member Timeout

• Comfort Greeting Frequency

• Max Waiting Time

For effective inbound call handling and providing a positive experience for inbound callers, we recommend
you to set the timers as per the following calculations:

Example for Parallel Hunt Method
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Set the Comfort Greeting Frequency as two times the value of Member Timeout and the Max Waiting Time
as the value equal to that of Member Timeout.

Member Timeout = 30 seconds

Comfort Greeting Frequency = 2 x Member Timeout = 2 x 30 = 60 seconds

Max Waiting Time = Member Timeout = 30 seconds

Example for Peer, Sequential, and Longest Idle Hunt Methods

Set the Comfort Greeting Frequency as two times the value of Member Timeout and the Max Waiting Time
as Member Timeout value multiplied by the number of members in the Hunt Group.

Members in the Hunt Group = 5

Member Timeout = 30 seconds

Comfort Greeting Frequency = 2 x Member Timeout = 2 x 30 = 60 seconds

Max Waiting Time = Number of Members x Member Timeout = 5 x 30 = 150 seconds

DescriptionField

Enter a unique name for the hunt list. To easily identify the hunt list,
consider appending the pilot extension to the name; for example, hl5001.
Group name must contain a minimum of 2 and a maximum of 12
characters.

Only the following characters are allowed: a-z, A-Z, 0-9,
space, hyphen(-), and underscore (_)

Note

Group Name

Enter a number to access the Hunt Group that serves as the pilot for the
hunt list. This number serves as the trigger for hunting to begin. Pilot
number can be any number equal to the length of extension. For example:

• If the extension length is 3, pilot number can be any number from
000 to 999

• If the extension length is 4, pilot number can be any number from
0000 to 9999

• If the extension length is 5, pilot number can be any number from
00000 to 99999

Note • The Pilot Number of the Hunt Groups cannot be the
same as any existing extension and cannot start with the
digit that is used for sending calls to voicemail
automatically and for placing intercom calls.

• The Pilot Number of the Hunt Groups cannot be the
same as any existing Pickup Group number.

Pilot Number
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DescriptionField

Click Add to add members to this hunt group from the Stations page
(ShowMember Directory). You can also search for the users by entering
member name or extension. All extensions that are assigned to users or
departments can be included as members of a Hunt Group. You must
add a minimum of two members (can include dynamic members) for a
hunt group.

Add Members

From the list of extensions that display, select which extensions must
be included in the hunt list.

Click Show Member Directory, to select the list of extensions for the
hunt list. Check the respective member's name and click OK.

Show Member Directory

Allows members that are not part of the Hunt Group to join and unjoin
the Hunt Group on a need basis using the softkeys displayed on the
screen.

Allow dynamic members

This field is visible only when "Allow dynamic members" is
checked.

Note

Number of dynamic members allowed for the hunt group. A minimum
of one dynamic member needs to be added.

Note • You can add a maximum of 20 Hunt Groups.

• The total number of members in a Hunt Group, including
static and dynamic members cannot exceed 32.

• If you check the "Allow dynamic members" check box
on the Hunt Groups page, ensure that you check the
"Hunt Group Login" check box for each dynamic
member extension under Manage Site > Extensions >
Basic Info page.

• Once a Hunt Group is created, you cannot modify the
Hunt Method. You have to delete and readd the Hunt
Group to modify the Hunt Method.

Max dynamic members
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DescriptionField

Select how BE4000 distributes the calls to members of the hunt list
based on one of the following hunt methods:

• Longest-idle—BE4000 only distributes a call to idle members,
starting from the longest idle member to the least idle member of
a hunt list.

• Parallel—Calls ring all numbers in that hunt group simultaneously.
The extension to first answer the call is connected.

• Sequential—Call hunting always starts with the first member in
the hunt group. Continues to each number in the group in the order
in which they are listed, from top to bottom, in the hunt group.

• Peer—Call hunting starts with the extension immediately after the
one that last rang. Ringing proceeds in a circular manner, that is
from left to right. That is, BE4000 distributes a call to idle or
available members starting from the (n+1)th member of a hunt list,
where the nth member is the member to which BE4000 most
recently extended a call. If the nth member is the last member of
a hunt list, BE4000 distributes a call starting from the top of the
hunt list.

Once a Hunt Group is created, you cannot modify the Hunt
Method. You have to delete and readd the Hunt Group to
modify the Hunt Method.

Note

Hunt Method
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DescriptionField

If no members of the hunt list are available to answer a call, you can
choose to perform one of the following:

• Disconnect Call—the call is disconnected.

• Route to Group Voicemail Box—the call is forwarded to a group
voicemail box. Enter the email address and extension associated
with the group voicemail box. Group Voicemail boxes are created
with the first member of the hunt group as the user owner of the
group.

Note • During initial deployment, a group voicemail box
is created including the members who are available
in the Hunt Group.

• When adding Hunt Group post site deployment,
ensure that you create a group voicemail box first.
Else, the drop-down list does not show "Route to
Group Voicemail Box" option.

• Route to Hunt Groups—the call is forward to another Hunt Group.
Select the Hunt Group from the drop-down list.

• Route to Other—the call is forwarded to any other number, such
as extensions.

• Route to Voicemail Box—the call is forwarded to the voicemail
box of a user.

When No Member is Available

Timer Settings

Enter the maximum time for a member's phone to wait before passing
the call to the other member's phone. This happens only for longest-idle,
sequential, and peer hunt methods. The range is from 3 to 60,000
seconds.

Member Timeout (3-60000 Sec)

Enables call queueing.Enable Call Queuing

This field is visible only when Enable Call Queuing check
box is checked.

Note

Set the frequency in which the pre-recorded voice message (comfort
greeting) is played while the callers wait in the queue. The range is from
30 to 120 seconds.

Comfort Greeting frequency
(30-120 Sec)

This field is visible only when Enable Call Queuing check
box is checked.

Note

Enter the maximum time to wait when the queue is busy or full before
routing the call to "When No Member is Available " destination. The
range is from 20 to 3600 seconds.

Max Waiting Time (20-3600 Sec)
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DescriptionField

Save your hunt group configuration settings.Save

Auto Attendant

Auto Attendant service (also referred to as a virtual receptionist), is a phone system that enables your callers
to be automatically transferred to an extension, eliminating the need for a receptionist and avoiding extended
waiting period. BE4000 provides you an automated phone answering facility to communicate effectively with
customers and improve your business operations. An auto attendant answers all incoming calls with an audio
greeting and options menu (different for open and closed hours). A maximum of five submenus with a
maximum depth of 3 levels can be configured. The caller can select a menu option to reach to the desired
extension.

You can define the number of times the menu options is played to the caller before the call reaches the drop
through destination. You can also define where the call lands if no action is performed by the caller even after
the defined number menu repetitions.

Auto Attendant Field Descriptions

DescriptionField

Enter the number that callers dial to reach auto attendant. A minimum
of four digits is required. Range is from 1000 to 9999.

Pilot Number

Number of times the audio file is played to the caller before the call
reaches the drop through destination. Value range is from 1 to 9. Default
value is 4.

How many times do you want
message to be played

Defines where the call lands if no action is performed by the caller even
after playing the menu for the defined number of repeats. You can
configure one of the following as the drop through destination:

• Route to Extension—All extensions are listed in the drop-down.

• Route to Voicemail Box—All extensions that have "Voicemail"
enabled are listed in the drop-down.

• Route to Hunt Group—All Hunt Groups are listed in the
drop-down.

• Route to Group Voicemail Box—All group voicemail boxes are
listed in the drop-down.

During the initial site deployment (in the Setup
Assistant), the drop-down shows an option, only if you
create a group voicemail box on theHunt Groups page,
by choosing "Route to Group Voicemail Box" from the
When No Member is Available drop-down list.

Note

• Disconnect Call—The call gets disconnected.

Drop Through Destination
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DescriptionField

Add an audio prompt for welcome Message. The BE4000 provides a
default audio file. This audio message is played first when a call is
answered by the auto attendant. You can also upload a new .wav file.
To select a new file, click Upload.

BE4000 supports only .wav audio file with G.711 u-law,
8kHz, 8 bit, Mono format. The file cannot be larger than 1
MB (about 2 minutes). The filename cannot have space and
special characters.

The system default message is a silent recording. You need
to replace the message with a custom recording.

Note

Audio Prompt (WelcomeMessage)

Add an audio prompt for open message. The BE4000 provides a default
audio file. This audio message is played when a call is answered during
the open business hours. You can also upload a new .wav file. To select
a new file, click Upload.

BE4000 supports only .wav audio file with G.711 u-law,
8kHz, 8 bit, Mono format. The file cannot be larger than 1
MB (about 2 minutes). The filename cannot have space and
special characters.

The system default message is a silent recording. You need
to replace the message with a custom recording.

Note

Audio Prompt (Open Message)

Add customizedmenu options. You can add 0-9menu options in addition
to a * menu. Each menu option can be labeled in a meaningful way to
help identify locations or users in your system using any one of the
following: Dial by Name, Pilot Number, Dial by Number, Call Hunt
Group, Return to Main Menu, or Submenu.

Add Menu Option

Displays the default audio file that is played for all calls received during
closed hours. You can play the existing file or upload a new .wav file.
To select a new audio file, click Upload.

BE4000 supports only .wav audio file with G.711 u-law,
8kHz, 8 bit, Mono format. The file cannot be larger than 1
MB (about 2 minutes). The filename cannot have space and
special characters.

The system default message is a silent recording. You need
to replace the message with a custom recording.

Note

Audio Prompt (Closed Message)

Add customizedmenu options. You can add 0-9menu options in addition
to a * menu. Each menu option can be labeled in a meaningful way to
help identify locations or users in your system using any one of the
following: Dial by Name, Pilot Number, Dial by Number, Call Hunt
Group, Return to Main Menu, or Submenu.

Add Menu Option
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Night Service

Night service allows you to transfer the incoming calls to a designated set of extensions during closed hours.
During the night service hours (also known as closed hours), calls coming in to the designated extension,
known as night service extensions, sends a special "burst" ring to night-service phones (phones that receive
the calls coming from the night service extension) that have been specified to receive the special ring. Phone
users at the night-service phones can then answer the incoming calls for the night-service extensions.

You can configure only one night-service phone per night-service extension.Note

Night Service Field Descriptions

DescriptionField

Enter a code to trigger Night Service feature manually during open
business hours.

Manual Activation Code must start with an asterisk (*) followed by a
minimum of 3 digits. A maximum of 15 digits can be configured
excluding the asterisk (*). Default value for manual activation code is
*1234.

Manual Activation Code

Enter the hours during which the Night Service must be active.

You cannot overlap the end time of Night Service and the start of
business open hours. For example, if your business closes at 17:00 and
opens next day at 09:00 AM, enter the Night Service hours as 17:00 and
08:59. You cannot enter 09:00 as it overlaps with the open business
hours. Night service hours must be entered in 24-hour time format.

Active Hours

Add the list of holidays for the organization.

Note • You can add holidays only for the current year and a
year ahead.

• Date should not be less than the present date.

Holidays

After enabling night service, you must the extensions for night service hours and to receive night service calls.
Refer Night Service section for more details.

Note

Inbound Call Mapping

You can map the incoming calls of a DID number to an Auto Attendant, Extension, or Hunt Group. You can
also set a default target for all the DID numbers belonging to a service provider.
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Inbound Call Mapping Field Descriptions

DescriptionsField

Names of the service providers are listed by default.Service Provider

Choose a default target for all incoming calls belonging to a service provider. If
there is a registered number that is not assigned with any target type, then the
incoming calls are place on the default target set for the service provider.

Choose one of the following: Hunt Group, Auto Attendant, Extension.

Default Target

Specify the number of digits sent by the service provider. Range is from 2 to 15
and All Digits.

Provider Send Digits

The DID numbers that are registered to SIP Trunk and Line Cards are listed by
default.

Registered Number

Choose one of the following:

• Auto Attendant—You can map the incoming calls on the DID number to
the Auto Attendant. The Auto Attendant menu options is played when the
callers dial the DID number. You choose one of the following as the target
number:

• Auto Attendant Pilot Number—Choose pilot number of the Auto
Attendant.

• Greeting Admin—You can assign a Direct Inward Dial (DID) number
as the number to log in the Auto Attendant Alternate admin settings.
The customer administrator (or an end user with
"PromptAdministrators" privileges), can dial the DID number instead
of 70397 to reach the Auto Attendant admin settings on the phone.

• Extension—You can select any one of the existing extensions. The incoming
calls on the DID number ring on the specified extension.

• Hunt Group—You can map the incoming calls on the DID number to an
existing hunt group. The incoming calls on the DID numbers ring on the
extensions belonging to the specified hunt group.

• Meet Me—You can map the incoming calls on the DID number to a Meet
Me conference number. The incoming calls on the DID numbers ring on
the Meet Me conference numbers that you configure.

Target Type

Choose a number from the drop-down list.Target Number

Outbound Caller ID

You can configure a specific DID number to be displayed on the called phone when an outbound call is placed
from an extension within the organization. You can also set a default outbound DID number for a service
provider.
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Outbound Caller ID Field Descriptions

DescriptionField

Names of the service providers are listed by default.Service Provider

Choose a default target for all outgoing calls of the service provider. An extension
without an assigned DID number displays the default outbound DID number
configured for the service provider.

Default Outbound DID

Displays the list of extensions available for the site.Mapped Extension

Choose a DID number to be displayed on the called phone when an outbound
call is placed from the extension within the organization.

Caller ID

System Operator

You can configure a number to be reached when a caller dials zero after listening to the personal voicemail
box greeting.

System Operator Field Descriptions

DescriptionField

Choose the one of the following as the system operator target type from the
Target Type drop-down list:

• Route to Extension—Any extension that is configured for the site.

• Route to Voicemail Box—Voicemail of any extension.

• Route to Hunt Group—Any hunt group that is configured for the site.

• Route to GroupVoicemail Box—Any group voicemail box that is configured
for the site.

• Route to Pilot Number—Any pilot number, such as Auto Attendant pilot
number.

Target Type

Choose the number corresponding to the target type selected from the Target
Number drop-down list.

Target Number

Features Field Descriptions
Paging

Paging provides one-way voice path to the phones that have been designated to receive paging. The paged
phone automatically answers the page in speakerphone mode with “Mute” activated.

By default, the BE4000 system creates a "PageAll" group that consists of all phones available in the site.

Click Add New Paging Group to add custom paging groups.
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DescriptionField

Name of the paging group. Enter a minimum of 2 and
a maximum of 30 characters.

Only 0-9 a-z A-Z !#%,-./=_? are allowed.Note

Group Name

Number that is designated to relay audio pages. Pilot
Number must contain same number of digits as that
of the extension length.

The first digit cannot be the same as the
digit used for dialing an outside line,
sending a call to voicemail automatically,
and dialing an intercom extension.

Note

Pilot Number

List of members in the paging group. Search for the
members using the username or extension. You can
also search for the members using the "Show
Directory" option.

Add Members

Creates a paging group or saves the changes that are
made to an existing paging group.

Save

Music on Hold Settings

DescriptionField

MoH allows you to play audio for incoming and outgoing calls placed on hold.
You can play the default audio file or upload a new audio file. To select a new
audio file, click Upload.

BE4000 supports only .au and .wav audio file with G.711; ITU-T
a-law or u-law, 8kHz, 8 bit, Mono format. The file cannot be larger
than 1 MB (about 2 minutes). The filename cannot have space and
special characters.

Note

Music on Hold (MoH)

Maintenance Schedule Field Descriptions

Maintenance Schedule allows you to designate a 2 hour block of time each day when it is safe for the system
to install software updates. The system may be offline and unable to make or receive phone calls during the
maintenance schedule. Select the day and time according to your organization’s preference.

You can also back up your site configurations on a regular interval. You can set the day and time during which
the system automatically backs up your site configuration. Check the "Back Up" check box for the days when
you want the site to back up the configurations.

The previous five consecutive backups are stored in the BE4000 portal.Note
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Licensing

You can associate the site with the Cisco Smart Account by providing the smart license token. The Smart
License Token field is a placeholder for entering the smart license token ID. Currently, the BE4000 does not
register to the Cisco Smart Account. If you enter a smart license token ID, we recommend setting a validity
date of at least 180 days when the token is created. Enter the smart license token ID received from Cisco in
the Smart License Token field.

Setup Assistant
43

Setup Assistant
Setup Assistant



Setup Assistant
44

Setup Assistant
Setup Assistant


	Setup Assistant
	Add Customer Field Descriptions
	Connectivity Field Descriptions
	Dial Plan Field Descriptions
	Stations Field Descriptions
	Call Routing Field Descriptions
	Features Field Descriptions


